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TRƯỜNG ĐẠI HỌC HỒNG ĐỨC 

TRUNG TÂM CNTT HỒNG DỨC 

CỘNG HOÀ XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

 

ĐỀ CƯƠNG ÔN TẬP  

KỲ THI CẤP CHỨNG CHỈ CNTT CƠ BẢN 

 

 

A. PHẦN SOẠN THẢO VĂN WORD 

I. NỘI DUNG ÔN TẬP 

1. Khái niệm văn bản, quy cách soạn thảo văn bản tiếng Việt 

2. Một số mẫu văn bản hành chính 

3. Các chức năng chính của một phần mềm xử lý văn bản Microsoft Word 2007  (thêm/ bớt các menu, 

ẩn/ hiện công cụ, thay đổi các thiết lập, thay đổi kích thước cửa sổ, thay đổi chế độ hiển thị,…) 

4. Các thao tác với tệp văn bản: tạo tệp mới, mở tệp đã có trên đĩa, lưu trữ tệp tin (với các định dạng 

khác nhau: .doc, .docx, rtf, pdf, txt,...) 

5. Các thao tác cơ bản trên khối văn bản: chọn (bôi đen), sao chép, di chuyển, xoá, tìm kiếm và thay 

thế, hủy kết quả vừa làm (undo), lấy lại kết quả vừa làm (redo), sao chép định dạng,… 

6. Tổ chức và định dạng văn bản: 

a) Định dạng ký tự (Text): font chữ, cỡ chữ, màu chữ, các kiểu hiển thị khác nhau (đậm, nghiêng, 

gạch dưới), chỉ số trên, chỉ số dưới,… 

b) Định dạng cho đoạn văn bản (Paragraph): lùi đầu đoạn, căn lề, độ rộng của dòng, khoảng cách 

giữa các đoạn, màu nền, tạo đường viền, ký tự đầu đoạn (Bullets and Numbering), chữ rơi (Drop 

cap), định vị Tabs,... 

c) Định dạng trang in (Page): khổ giấy, hướng giấy (ngang - landscape, dọc - portrait), chia cột 

báo (Columns), lề trang (trên, dưới, trái, phải), ngắt trang,… 

7. Chèn đối tượng vào văn bản và thao tác trên các đối tượng đó: ký tự đặc biệt, hình ảnh, khung chữ, 

chữ nghệ thuật, số trang, tiều đề đầu trang (header), tiêu đề cuối trang (footer), chú thích tại chân 

trang (footnote), chú thích tại cuối bài (endnote), ngắt trang, đường kẻ, hình cơ bản, công thức toán 

học, biểu đồ,.... 

8. Bảng biểu: chèn bảng, xóa bảng, xoá cột, xoá dòng, thêm cột, thêm dòng, tách ô, trộn ô, tách bảng, 

chọn (ô, dòng, cột, toàn bộ bảng), định dạng bảng (thay đổi chiều cao dòng, độ rộng cột, đường 

viền, màu sắc), sắp xếp dữ liệu trong bảng, tính toán trong bảng,.. 

9. In văn bản: xem văn bản trước khi in, in một số trang, in toàn bộ văn bản, in trang chẵn, in trang lẻ, 

in 1 bản, in nhiều bản,… 

10. Một số kỹ thuật: hiệu ứng điều chỉnh tự động (autocorrect), bật/tắt chế độ kiểm tra lỗi, xử lý lỗi khi 

sao chép và dán (smart cut and paste). 

11. Một số phím tắt thông dụng khi thao tác với văn bản. 

12. Thiết lập các chế độ bảo vệ văn bản. 

II. HƯỚNG DẪN ÔN TẬP  

1. Phần trắc nghiệm 

Câu 1: Trong các phần mềm sau đâu là phần mềm có thể dùng để soạn thảo văn bản? 

A. Microsoft Word, Microsoft Paint, OpenOffice Writer 

B. Microsoft Word, Microsoft Paint, Microsoft Excel 
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C. Microsoft Word, LibreOffice Writer, Microsoft Excel 

D. Microsoft Word, LibreOffice Writer, OpenOffice Writer  

Câu 2: Trong Word để hiển thị hộp thoại thay thế văn bản, ta ấn tổ hợp phím: 

A. Ctrl + S 

B. Ctrl + F 

C. Shift + R 

D. Ctrl + H 

Câu 3: Trong Word để có thể đánh chỉ số dưới, ví dụ như H2O, cần ấn tổ hợp phím nào? 

A. Ctrl + = 

B. Ctrl + Shift + = 

C. Ctrl + Alt + = 

D. Shift + = 

Câu 4: Trong Word để căn lề đều hai bên cho đoạn văn bản đã chọn ta ấn tổ hợp phím nào sau đây? 

A. Ctrl + R 

B. Shift + L 

C. Ctrl + J 

D. Ctrl + E 

Câu 5: Trong Word 2007 để ngắt cột văn bản, ta kích chọn: 

A. Page Layout → Break → Page 

B. Page Layout → Break → Column  

C. Home → Break → Page 

D. Home → Break → Column 

Câu 6: Trong Word 2007, để chèn vào văn bản những ký tự đặc biệt (,…), ta kích chọn: 

A. Insert  Auto Text 

B. Insert  Equation 

C. Insert  Symbol  

D. Insert  Word 

Câu 7: Trong Word 2007 để dãn khoảng cách giữa các đoạn văn bản, ta chọn Page Layout, trong nhóm 

Paragraph chọn: 

A. Indents and Spacing → Spasing 

B. Indents and Spacing → Line Spasing 

C. Line and Page Breaks → Spasing 

D. Line and Page Breaks → Line Spasing 

Câu 8: Trong Word 2007 để chọn hướng in ngang ta lựa chọn: 

A. Page Layout → Page Setup → Thẻ Margins → Portrait 

B. Page Layout → Page Setup → Thẻ Margins → Landscape 

C. Page Layout → Page Setup → Thẻ Paper → Landscape 

D. Page Layout → Page Setup → Thẻ Paper → Portrait 

Câu 9: Mục Save AutoRecover information every để xác lập: 

A. Thời gian để lưu file tự động 

B. Thời gian để mở file tự động 

C. Thời gian để đóng file tự động 
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D. Thời gian để lưu file dưới định dạng một tên khác 

Câu 10: Để thay đổi thư mục lưu văn bản mặc định ta thực hiện: 

A. Office /Save/Default file location 

B. Office /Options/Save/Auto Recover file location 

C. Office/Options/Save/Default file location  

D. Office /Save/Defaunt file location 

Đáp án:   1.D 2.D 3.A 4.C 5.B 6.C 7.A 8.B 9.A 10.C 

2. Phần thực hành 

CÂU 1: 1. Khởi động chương trình Microsoft Word 2007, soạn thảo văn bản có nội dung sau, lưu lên đĩa 

với tên tệp là QUYET DINH vào thư mục riêng là số báo danh của anh/chị. 

2. Định dạng theo mẫu; giãn dòng kiểu Multiple 1.3, giãn đoạn trên 2pt; chọn cỡ giấy A4, hướng giấy đứng, 

đặt lề trên 2cm, lề dưới 2cm, lề trái 3cm, lề phải 2.5cm. 

 

ỦY BAN NHÂN DÂN  

TỈNH THANH HÓA 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc  
Số: 38/QĐ-UBND 

 

Thanh Hóa, ngày 03 tháng 01 năm 2018 

 

QUYẾT ĐỊNH 
VỀ VIỆC BAN HÀNH KẾ HOẠCH HÀNH ĐỘNG THỰC HIỆN NGHỊ QUYẾT CỦA CHÍNH PHỦ, 

NGHỊ QUYẾT CỦA TỈNH ỦY, HĐND TỈNH VỀ NHIỆM VỤ PHÁT TRIỂN KINH TẾ - XÃ HỘI 

NĂM 2018 

ỦY BAN NHÂN DÂN TỈNH THANH HÓA 

Căn cứ Luật Tổ chức chính quyền địa phương ngày 19/6/2015;  

Căn cứ Nghị quyết số 01/NQ-CP ngày 01 tháng 01 năm 2018 của Chính phủ về những nhiệm vụ, giải 

pháp chủ yếu chỉ đạo điều hành thực hiện kế hoạch phát triển kinh tế - xã hội và dự toán ngân sách nhà 

nước năm 2018; 

Căn cứ Nghị quyết số 08-NQ/TU ngày 04 tháng 12 năm 2017 của Ban Chấp hành Đảng bộ tỉnh về 

phương hướng, nhiệm vụ năm 2018; 

Căn cứ Nghị quyết số 74/NQ-HĐND ngày 07 tháng 12 năm 2017 của Hội đồng nhân dân tỉnh Thanh 

Hóa về kế hoạch phát triển kinh tế - xã hội năm 2018; 

Xét đề nghị của Chánh Văn phòng Ủy ban nhân dân tỉnh Thanh Hóa, 

 

QUYẾT ĐỊNH: 

Điều 1. Ban hành kèm theo Quyết định này Kế hoạch hành động thực hiện nghị quyết của Chính phủ, nghị 

quyết của Tỉnh ủy, HĐND tỉnh về nhiệm vụ phát triển kinh tế - xã hội năm 2018. 

Điều 2. Quyết định này có hiệu lực thi hành kể từ ngày ký. 

Chánh Văn phòng UBND tỉnh, Giám đốc các sở, Trưởng các ban, ngành cấp tỉnh, Chủ tịch UBND các 

huyện, thị xã, thành phố và Thủ trưởng các cơ quan, đơn vị liên quan chịu trách nhiệm thi hành Quyết định 

này./. 

   TM. ỦY BAN NHÂN DÂN  

CHỦ TỊCH 
 

 

 

https://thuvienphapluat.vn/van-ban/thuong-mai/nghi-quyet-01-nq-cp-2018-giai-phap-chu-yeu-thuc-hien-ke-hoach-phat-trien-kinh-te-xa-hoi-371009.aspx
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Nguyễn Đình Xứng 

 CÂU 2: 1. Khởi động chương trình Microsoft Word 2007, soạn thảo văn bản có nội dung sau, lưu lên đĩa 

với tên tệp là HOP DONG vào thư mục riêng là tên của anh/chị.  

2. Định dạng theo mẫu; giãn dòng kiểu Multiple 1.2, giãn đoạn trên 3pt; chọn cỡ giấy A4, hướng giấy đứng, 

đặt lề trên 2cm, lề dưới 2cm, lề trái 3cm, lề phải 2cm. 

 

CỘNG HOÀ XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc 

 

HỢP ĐỒNG MUA BÁN HÀNG HOÁ 

Số     /20……/HĐMB 

                                                    

Căn cứ Bộ Luật Dân sự được Quốc hội nước Cộng hoà xã hội chủ nghĩa Việt Nam thông qua ngày 

14 tháng 6 năm 2005; 

Căn cứ nhu cầu và khả năng của hai bên, 

Hôm nay, ngày 15 tháng 06 năm 2018, tại Công ty TNHH Minh Phong, chúng tôi gồm có: 

BÊN MUA: Trường Mầm non Mặt trời 

Địa chỉ: Số15, đường Lê Lợi - TP. Thanh Hoá. Điện thoại: 037.850.510 

Đại diện bởi:  bà Lê Thanh Mai      Chức vụ: Hiệu trưởng   

Mã số thuế: ……………………………   

Tài khoản số: …………………… tại ngân hàng ……………….……………………... 

Sau đây gọi tắt là Bên A 

BÊN BÁN: Công ty TNHH Minh Phong 

Địa chỉ: Số15, đường Lê Lai - TP. Thanh Hoá. Điện thoại: 037.911.110   

Đại diện bởi:  ông Đỗ Bá Chi    Chức vụ: Giám đốc Công ty 

Mã số thuế: ……………………………   

Tài khoản số: …………………… tại ngân hàng ……………….……………………... 

Sau đây gọi tắt là Bên B  

Hai bên A và B thống nhất thoả thuận nội dung Hợp đồng như sau: 

Điều 1: Đối tượng và giá cả 

Đơn vị tính: 1000 đồng 

STT Tên hàng hoá 
Đơn 

vị 

Số 

lượng 

Đơn giá 

(VNĐ) 

Thành tiền 

(VNĐ) 

1      

2      

… Cộng tiền hàng    Bằng chữ:  

 Thuế GTGT (….%)     

 Tổng tiền thanh toán     

 

Giá cả trên chưa bao gồm thuế Giá trị gia tăng. 

Hàng hoá do Bên Bán cung cấp phải đảm bảo đúng chất lượng (Có Giấy chứng nhẫn hàng hoá cung 

cấp đạt tiêu chuẩn chất lượng của cơ quan Nhà nước có thẩm quyền) 

Điều 2: … 
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Hợp đồng được lập thành 02 bản có giá trị pháp lý như nhau mỗi bên giữ 01 bản./. 

Đại diện bên A 

(Ký, ghi rõ họ tên) 

Đại diện bên B 

(Ký, ghi rõ họ tên) 

 

CÂU 3: 1. Khởi động chương trình Microsoft Word, soạn thảo và định dạng văn bản có nội dung sau, lưu 

lên đĩa với tên tệp là CHUNG CHI vào thư mục riêng có tên là THICC. 

 

 

B. PHẦN BẢNG TÍNH EXCEL 

I.  Nội dung ôn tập 

1.  Kiến thức cơ bản về bảng tính:  

- Hiểu khái niệm và công dụng của bảng tính, nắm được các bước để xây dựng và ứng dụng bảng tính thông 

thường. Nhập và định dạng dữ liệu, nhập công thức vào bảng tính và tính toán trên dữ liệu bằng cách áp 

dụng các phép tính, biểu thức, hàm; biểu diễn trực quan dữ liệu dưới dạng biểu đồ; biết một số ứng dụng 

cao cấp như phân tích dữ liệu, dự báo; in và phân phối các bảng tính.  

- Biết một số phần mềm bảng tính khác nhau như LibreOffice Calc, OpenOffice Calc, Microsoft Excel.   

2. Sử dụng phần mềm bảng tính Excel. 

2. 1. Cơ bản về excel. 

- Biết các cách mở, đóng bảng tính excel trực tiếp và gián tiếp. Hiểu được màn hình làm việc, biết ẩn, hiện 

các thanh công cụ và thoát khỏi excel. 

- Biết chỉnh sửa các thiết đặt để mở và lưu bảng tính như chọn thư mục mặc định, tên tệp mặc định, định 

dạng mặc định. Sử dụng được chức năng trợ giúp của Excel. 

- Biết mở, đóng một bảng tính có sẵn. Biết mở nhiều bảng tính và sắp xếp các cửa sổ để làm việc đồng thời. 

Biết sử dụng công cụ phóng to, thu nhỏ khi xem một bảng tính. 

- Biết tạo bảng tính mới theo mẫu cho trước. Biết các kiểu tệp dùng để lưu bảng tính.  Biết cách lưu bảng 

tính vào thư mục với tên cũ hoặc đổi sang tên khác, bằng một kiểu tệp khác. 

- Biết cách chuyển từ bảng tính đang mở này sang bảng tính đang mở khác 

- Hiểu và thao tác đối với ô, dòng, cột và vùng dữ liệu trong excel. 

- Biết nhập, hiệu chỉnh và xóa dữ liệu ô. Hiểu và phân biệt các loại địa chỉ của ô. Biết cách chọn một ô, 

nhiều ô liền kề, nhiều ô không liền kề, toàn bộ trang tính. 

- Biết chọn hàng (nhiều hàng), cột (nhiều cột), chèn hàng, chèn cột và xóa hàng, xóa cột. Biết thay đổi chiều 

rộng cột, chiều cao dòng. Biết cách ẩn/hiện, cố định (freeze)/thôi cố định (unfreeze) tiêu đề dòng, cột.  

- Biết các kiểu dữ liệu, cách nhập và định dạng dữ liệu, nhập chuỗi số tự động trong Excel.   

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập- Tự do- Hạnh phúc 

---------------------------- 

   

CHỨNG CHỈ TIN HỌC 

 Ngành: Tin học Ngày thi: 15/06/2018  

 Trình độ:  B 

 Họ tên:  Lê Thị Ánh Tuyết 

 Ngày sinh: 10/05/1989 

 Nơi sinh: TP Thanh Hóa, tỉnh Thanh Hóa 

  Thanh Hóa, ngày 15 tháng 07 năm 2018  

     Giám đốc trung tâm 

 

 

 

 Trần Quang Minh

  

 
Ảnh 3 x 4 
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- Biết cách tìm ô theo nội dung. Biết cách thay thế nội dung ô trong trang tính. Biết cách sắp xếp các ô theo 

một số tiêu chí: thứ tự tăng giảm của số, thứ tự của chữ cái trong từ điển. Sao chép, di chuyển nội dung của 

ô trong trang tính, từ trang tính này sang trang tính khác, từ bảng tính này sang bảng tính khác. 

- Biết cách thêm một trang tính mới, đóng, xóa, đặt tên, sửa tên trang tính. 

2.2.  Biểu thức và hàm trong excel. 

a) Đối với biểu thức số học 

-  Biết khái niệm biểu thức (expression) và ứng dụng của biểu thức. Hiểu và biết cách dùng các địa chỉ 

tương đối, tuyệt đối của ô trong biểu thức. 

- Biết tạo biểu thức số học đơn giản bằng cách sử dụng các phép tính số học. 

- Hiểu các lỗi gặp phải khi sử dụng biểu thức (Ví dụ: #NAME?, #DIV/0!, #REF!). 

b. Đối với hàm trong excel. 

- Hiểu ý nghĩa, cú pháp và biết cách sử dụng các hàm thông dụng trong Excel: 

Nhóm hàm xử lý văn bản và chuỗi (Left, Right, Mid, Value,….), Nhóm hàm Logic (And, Or, If,  not…), 

Nhóm hàm ngày tháng và  thời gian (Today, Day, Month, Year,  Weekday,  Now, Date, Time…), Nhóm 

hàm toán học (Round, int, mod, Sum, Sumif,  Sumproduct,….), Nhóm hàm thống kê (Các hàm: 

AVERAGE, COUNT, COUNTA, COUNTIF, RANK, MAX, MIN) và Nhóm hàm tìm kiếm và tham chiếu 

trong bảng(VLOOKUP,  HLOOKUP,  INDEX….), 

3. Biểu đồ 

4.1. Tạo biểu đồ 

 - Biết cách tạo các loại biểu đồ khác nhau từ dữ liệu bảng tính, cách chọn một biểu đồ và cách thay đổi 

loại biểu đồ. 

4.2. Hiệu chỉnh biểu đồ 

- Biết chỉnh sửa, cắt, dán, di chuyển, xóa biểu đồ, di chuyển tiêu đề, ghi chú cho biểu đồ.  

- Biết cách thêm, di chuyển nhãn dữ liệu thay đổi màu nền, màu phụ đề cho biểu đồ. 

- Biết cách thay đổi kích cỡ phông chữ, màu của tiêu đề biểu đồ, trục biểu đồ, chú giải biểu đồ. Biết cách 

thay đổi kích thước biểu đồ. 

4. Định dạng trang và in ấn  

4.1. Định dạng trang tính. 

- Biết cách thay đổi lề: trên, dưới, trái, phải. Biết cách thay đổi hướng trang: dọc, ngang;  

- Biết cách hiệu chỉnh nội dung của phần header, footer của trang tính.  

- Biết cách thêm và xóa các trường: số trang, ngày, tháng, giờ, tên tệp, tên trang tính vào trong đầu trang, 

chân trang. 

4.2. Kiểm tra và in  

- Biết cách kiểm tra và sửa lỗi phép tính, lỗi văn bản và xem trang bảng tính trước khi in. 

- Biết cách hiện/ẩn đường kẻ ô lưới, đề mục dòng, cột khi in. 

- Biết áp dụng việc in tiêu đề dòng tự động trên mọi trang của trang bảng tính được in. 

- Biết cách chọn số lượng bản sao của trang tính, toàn bộ bảng tính, biểu đồ 

được chọn khi in ra. Biết cách in một dãy ô được chọn, biểu đồ trong trang tính; in toàn bộ trang tính. 

4.3. Phân phối trang tính  

- Biết cách lưu trang tính, bảng tính dưới các kiểu tệp khác nhau như .pdf hoặc định dạng của các phiên bản 

khác. 

- Biết cách đặt mật khẩu để kiểm soát truy nhập tệp trang tính, bảng tính. 

- Biết cách đính kèm trang tính theo thư điện tử. 

- Biết cách lưu trang tính trên mạng (ghi vào các ổ mạng, các thư mục trực tuyến). 

II. Một số ví dụ cơ bản 

1. Lý thuyết. 

Chọn phương án bạn cho là đúng 

Câu1.  Trong bảng tính Excel 2007, tổ hợp phím nào dùng để chèn thêm một sheet mới? 

A. Ctrl + F11;               B. Ctrl + F1;        C. Shift + F11;        D. Ctrl + Shift + F1 

Câu2. Trong bảng tính Excel công thức tham chiếu dữ liệu từ Sheet khác có dạng:  
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A. 'Tên Sheet tham chiếu'! Địa chỉ ô tham chiếu   

B. Địa chỉ ô tham chiếu!'Tên Sheet tham chiếu'  

C. 'Tên Sheet tham chiếu'#Địa chỉ ô tham chiếu 

D. 'Tên Sheet tham chiếu'&Địa chỉ ô tham chiếu 

Câu3. Trong MS Excel 2007, một trong các cách View sau không dược hỗ trợ khi đang thao tác trên 

Workbook:  

A. Sheet View;      B. Normal View;       C. Print Preview;        D. Custom View 

Câu4. Chức năng của một phần mềm xử lý bảng tính là gì? 

A. Tổ chức, phân tích và lưu trữ dữ liệu thông qua các bảng biểu 

B. Cập nhật, tổ chức và lưu trữ dữ liệu thông qua các biểu thức tính toán 

C. Cập nhật, phân tích và lưu trữ dữ liệu thông qua các biểu thức tính toán 

D. Tổ chức, phân tích và xứ lý dữ liệu thông qua các bảng biểu 

Câu5. Phần mềm nào dưới đây không phải là phần mềm bảng tính? 

A. Balsamiq;     B. Microsoft Excel;        C. Corel Quattro Pro;         D. Numbers 

Câu6. Trong Microsoft Excel 2007, có thể ẩn thanh công cụ Ribbon bằng cách nhấn tổ hợp phím: 

A. Crtl + F1;              B. Alt + F1;          C. Ctrl + F4;          D. Alt + F4 

Câu7. Đâu là một một kiểu dữ liệu của excel 

A. A005;                    B. 50C;                 C. #3C;                  D. $5C 

Câu 8. Để chèn thêm Sheet trong Excel ta đứng tại vị trí các Sheet kích chuột phải và chọn 

A. Insert\Work Sheet;             B. ReName;          C. Delete                    D. Move or copy 

Câu 9. Trong MS Excel 2007, để chọn nguyên 1 hàng ta dùng tổ hợp phím nào? 

A. Shift+Space;        B. Ctrl+L;           C. Ctrl+Space;           D. Alt+Space 

Câu 10. Để tính tổng các ô từ A1 đến A7, công thức nào dưới đây là đúng 

A. =SUM(A1):SUM(A7)         B. =SUM(A1- A7) 

C. =SUM(A1:A7)                     D. =SUM(A1);SUM(A7) 

Câu11. Trong MS Excel 2007, khi lập công thức tại ô A3 của Sheet 1 nhưng muốn tham chiếu đến 

dữ liệu vào ô B3 trong Sheet2 và nhân với 1000 thì công thức đúng là: 

A. Sheet2!B3*1000;         B. Sheet1!B3*1000;      C. B3!Sheet2*1000;    D. B3*1000 

Câu12. Trong bảng tính Excel 2007, tại ô A2 có sẵn giá trị 0 (số không); Tại ô B2 gõ vào công thức 

=5/A2 thì nhận được kết quả: 

A. #DIV/0!;                  B. 5;               C. #VALUE!;                    D. 0 

Câu13. Trong bảng tính Excel 2007, Khi nhập công thức tính trong Excel, nếu không tham chiếu 

được sẽ có thôngbáo: 

A. Lỗi #REF;                 B. Lỗi #NA;               C. Lỗi #NUM ;                   D Lỗi #VALUE 

Câu14. Trong MS Excel 2007, hộp thoại nào được sử dụng để tùy chỉnh định dạng số thập phân?   

 A. Hộp thoại Format Cells;                         B. Hộp thoại Font;   

 C. Hộp thoại Number;                                 D. Hộp thoại Page Setup 

Câu15. Trong Excel 2007, để thêm tiêu đề cho biểu đồ trong tab Chart Tools, ta chọn: 

A.Layout ->Chart Title;                 B.  Layout ->Axis Titles;   

C. Design -> Chart Title;                D. Format -> Chart Title 

Câu16. Để đặt mật khẩu cho Excel 2007, ta thực hiện: 

A. Office button -> Prepare ->Encrypt Document 

B. Data -> Prepare ->Encrypt Document 

C. Home -> Prepare ->Encrypt Document 

D. File -> Save -> Prepare ->Encrypt Document 

Câu17. Trong bảng tính Excel, hàm nào dùng để tìm kiếm theo cột: 

A.Vlookup;              B. Month;                  C. Left;           D. Len 
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Câu 18. Trong bảng tính MS Excel, hàm nào sau đây cho phép đếm các ô có dữ liệu. 

A. COUNTA;         B. SUMIF;                 C. COUTIF ;               D. D. SUM 

Câu 19: Hàm Left(“Micrsoft Excel”,3) cho kết quả: 

A. Mic                     B.Cel;                C. Sof                      D. Micr 

Câu 20: Hàm ROUND(21.79,1) cho kết quả : 

A. 21.8                     B. 21.7;              C. 21                       D. 22 

 

2. Thực hành 

Câu 1: 1) Mở chương trình xử lý bảng tính Excel, tạo tệp có tên là TKKQTSN.xlsx, với ký tự cuối N là số báo 

danh của thí sinh dự thi, lưu tệp vừa tạo vào thư mục đã tạo ở câu 1. 

THỐNG KÊ KẾT QUẢ THI TUYỂN SINH 

       Điểm Chuẩn: 22 

STT SBD Họ lót Tên Toán Lý Hóa 
Điểm 

ưu tiên 

Tổng 

điểm 

Kết 

quả 

 KV1A01 Ngô Kim  Loan 4 8 6    

 KV2A02 Hà Thanh  Tuấn 5 6 5    

 KV3C04 Lê Trung  Tuấn 7 8 7    

 KV1A02 Lê Thị  Lan 8 9 9    

 KV2A04 Đỗ Thị  Mai 2 3 3    

 KV1B05 Trần Quốc  Huy 2 3 5    

Bảng 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

Câu2: 1) Mở chương trình xử lý bảng tính Excel, tạo tệp có tên là CHNSN.xlsx, với ký tự cuối N là số 

báo danh của thí sinh dự thi, lưu tệp vừa tạo vào thư mục đã tạo ở câu 1. 

CỬA HÀNG NÔNG SẢN MỘC CHÂU 

Stt Mã HĐ Ngày HĐ Tên SP 
Số 

lượng(kg) 

Loại 

hàng 

Đơn 

Giá(đ) 

Thành 

tiền(đ) 

1 GN0123K1 21/05/2015  1500    

2 DN0123K3 21/05/2015  2250    

3 GN0225K1 21/05/2015  2500    

4 GN0126K1 24/05/2015  6000    

5 ĐX0128K2 24/05/2015  2150    

6 GN0223K1 25/05/2015  1500    

7 ĐX0123K3 25/05/2015  1250    

8 GN0223K2 28/05/2015  1500    

9 DN0123K3 29/05/2015  1250    

Bảng 1: Tên hàng - đơn giá 

Mã SP Tên SP Đơn giá 1 Đơn giá 2 

DN Dừa nước 12000 12500 

GN Gạo 18000 19000 

Khu 

vực 

Điểm 

ưu tiên 

KV1 0.5 

KV2 1 

KV3 1.5 

 

2.Tính điểm ưu tiên dựa theo bảng 1 và 3 ký tự đầu của SBD.  

3. Tính Tổng điểm = tổng điểm 3 môn Toán, Lý, Hóa và điểm ưu tiên.  

4. Chèn thêm cột vị thứ trước cột kết quả. Căn cứ cột tổng điểm điền dữ liệu 

cho cột vị thứ.  

5. Điền dữ liệu cho cột kết quả biết: nếu thí sinh có tổng điểm ≥ điểm chuẩn 

thì "Đậu" ngược lại thì "Trượt".  

6. Cho biết số sinh viên đậu, số thí sinh trượt. 

7. Lọc ra địa chỉ mới danh sách các thí sinh đậu. 

8. Cho biết có bao nhiêu thí sinh có tổng điểm >=20. 

9. Tính điểm thi cao nhất, thấp nhất. 

10. Vễ biểu đồ thể hiển tỷ lệ đậu, trượt của các thí sinh. 

11. Sắp xếp dữ liệu theo tên, nếu trùng tên thì sắp xếp theo họ lót. 
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ĐX Đậu xanh 30000 32000 

 

Lưu ý: Đơn vị là: Dừa (Quả); Gạo và Đậu xanh (Kg). 

2) Điền Loại hàng dựa vào ký tự thứ 4 của Mã HĐ. 

3) Điền Tên SP dựa vào 2 ký tự đầu của của Mã HĐ đơn và Bảng 1. 

4) Điền Đơn giá dựa vào Tên SP và Bảng 1. Biết loại hàng1 thì đơn giá1; loại hàng 2 thì đơn giá 2. 

5) Cột Thành tiền = số lượng*Đơn giá 

6) Tổng hợp thành tiền theo tên sản phẩm 

7) Lọc ra địa chỉ mới mặt hàng là gạo có số lượng>2000kg. 

8) Dùng lệnh subtolal tính tổng số (kg) của từng lọa sản phẩm.  

9) Vẽ biểu đồ thể hiện doanh số của từng lọa sản phẩm 

 

Câu3: 1) Mở chương trình xử lý bảng tính Excel, tạo tệp có tên là BĐSN.xlsx, với ký tự cuối N là số báo 

danh của thí sinh dự thi, lưu tệp vừa tạo vào thư mục đã tạo ở câu 1. 

BÁO CÁO KINH DOANH BẤT ĐỘNG SẢN THÁNG 12/2017 

Stt Ngày Mã hàng 
Tên 

BĐS 
Nhà cung cấp Số lượng 

Đơn giá 

(USD) 

Thành 

tiền(USD) 

1 02/12/2016 BT1-ĐA   100   

2 06/12/2016 PL1-VI   200   

3 10/12/2016 BT2- VI   50   

4 11/12/2016 PL2-ĐA   200   

5 19/12/2016 PL2-ĐA   45   

                    Bảng 1- bảng tham chiếu 

Mã hàng 
Tên BĐS ĐA VI 

Nhà cung cấp Đông Á Vingroup 

BT Biệt thự 500000 75000 

PL Phân lô 50000 45000 

 

Chú thích: 2 ký đầu của Mã hàng thể hiện tên Bất động sản, 2 ký tự cuối cho biết nhà cung cấp. 

2) Dựa vào cột Mã hàng để điền dữ liệu cho cột tên hàng; nếu 2 ký tự đầu của cột mã hàng là BT thì điền 

là Biệt thự; 2 ký tự đầu của cột Mã hàng là PL thì điền là Phân lô. 

3) Dựa vào 2 ký tự cuối của cột mã hàng và bảng 1 để điền Nhà cung cấp. 

4) Thành tiền = Số lương*Đơn giá; đơn giá căn cứ vào Bảng 1. 

 

C. PHẦN TRÌNH CHIẾU POWER POINT + INTERNET 

I. Mục tiêu 

- Sử dụng trình chiếu cơ bản (Mã IU05) 

- Sử dụng máy tính cơ bản (Mã IU02) 

- Sử dụng Internet cơ bản (Mã IU06) 

- Hiểu biết về CNTT cơ bản (Mã IU01) 

II. Nội dung 

1. Tạo thư mục hoặc tệp tin. Tại nơi cần tạo thư mục/tệp tin 
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2. Cách chụp màn hình 
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3. Giao diện trung tâm điều khiển Ribbon của MS Powerpoint 

 
Ribbon bao gồm một số tab với chức năng cụ thể như sau: 

Insert: Đây là nơi người sử dụng có thể thêm vào trên slide từ table, hình ảnh, biểu đồ, đoạn text, âm thanh, 

header và footer. 

Design: Là nơi định dạng cho slide có hình thức đẹp hơn, bao gồm cách thiết kế thông tin nền, font chữ và 

cách sắp xếp màu sắc. 

Animations: Đây là tab tạo nên hiệu ứng cho bài thuyết trình. Người sử dụng có thể dễ dàng dùng nhiều 

hiệu ứng trên tab này. 

Slide Show: Khi bắt đầu thuyết trình thì chắc chắn rằng người sử dụng phải sử dụng tab này. Ngoài ra nó 

còn chức năng thu lại bài tường thuật trong suốt bài thuyết trình, bên cạnh chức năng chuẩn bị bài thuyết 

trình. 

Review: Tab này cho phép kiểm tra chính tả đảm bảo an toàn cho bài thuyết trình. 

View: Tab này cho phép xem lại bài thuyết trình và sắp xếp lại bài thuyết trình trên cửa sổ. 

4. Tạo mới slide trình chiếu 
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5. Chọn kiểu bố cục (Layout) 

 
6. Nhập nội dung văn bản vào slide 

 
7. Tạo ghi chú (notes) 
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8. Chọn chủ đề (themes) 

  
9. Chèn hình ảnh 

 
10. Tạo đồ họa SmartArt 
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11. Chèn âm thanh, video 

 
12. Sử dụng Header & Footer 
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13. Tạo hiệu ứng 

 

 
14. Hiệu ứng chuyển slide 

 
15. Chèn chữ nghệ thuật WordArt 
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III. Bài tập 

Câu 1. Xây dựng 1 bài trình chiếu như sau 
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Câu 2. Xây dựng bài trình chiếu như mẫu sau 

  

  

  
IV. Một số câu hỏi tự ôn tập 

I. Module sử dụng trình chiếu cơ bản (Mã IU05) 

1. Biết khái niệm bài thuyết trình. Biết các nhân tố ảnh hưởng đến chất lượng thuyết trình và một số chỉ 

dẫn để tạo nên một bài thuyết trình tốt. 

2. Biết các bước chính trong tạo và thực hiện bài thuyết trình: Xác định mục tiêu thuyết trình; thiết kế, biên 

tập nội dung các trang của bài thuyết trình; lưu và phân phát (publish) nội dung bài thuyết trình; thực hiện 

việc thuyết trình bằng một công cụ trình chiếu. 
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3. Biết một số phần mềm trình chiếu như LibreOffice Impress, OpenOffice Impress, Microsoft Powerpoint. 

4. Biết các chức năng chính của một phần mềm trình chiếu cụ thể. 

5. Biết các cách mở một phần mềm trình chiếu: mở trực tiếp phần mềm, mở gián tiếp thông qua việc mở 

một tệp thuyết trình được xây dựng bởi phần mềm đó. Biết cách đóng phần mềm. 

6. Nhận biết màn hình làm việc của phần mềm và các thành phần của nó. Biết cách hiện/ẩn thanh công cụ, 

thanh ruy-băng trên màn hình. 

7. Biết sử dụng chức năng trợ giúp, chức năng hướng dẫn thực hiện theo bước có sẵn (wizard). 

8. Biết các cách mở, đóng bài thuyết trình hiện có. Biết cách chọn mở bài thuyết trình theo yêu cầu như 

theo tên người dùng, theo thư mục mặc định. 

9. Biết cách tạo một bài thuyết trình mới dựa trên mẫu (template) mặc định. Biết các kiểu tệp dùng để lưu 

bài thuyết trình. 

10. Biết các cách hiển thị (view) bài thuyết trình khác nhau. Biết cách chuyển từ cách hiển thị này sang 

cách hiển thị khác. 

11. Biết các cách lưu bài thuyết trình vào thư mục (giữ tên cũ, đổi sang tên khác, đổi kiểu tệp khác). 

12. Biết cách mở nhiều bài thuyết trình đồng thời và chuyển từ bài thuyết trình này sang bài thuyết trình 

khác. 

13. Hiểu khái niệm trang thuyết trình (slide) và vai trò của nó trong bài thuyết trình. 

14. Biết các khái niệm đi kèm trang thuyết trình: Tiêu đề (title), bố cục (layout), mẫu thiết kế sẵn (design 

template), chủ đề (theme), hiệu ứng động (animation). 

15. Hiểu khái niệm bố cục và biết các bố cục chuẩn đối với trang thuyết trình. Biết chọn kiểu bố cục trang 

thuyết trình (dùng kiểu đang có hoặc chọn kiểu khác). Biết cách thêm một trang thuyết trình mới với bố 

cục cụ thể. 

II. Module sử dụng máy tính cơ bản (Mã IU02) 

1. Biết trình tự thông thường các công việc cần thực hiện khi sử dụng máy tính: Mở máy và đăng nhập vào 

hệ thống, sử dụng các công cụ của hệ điều hành để chuẩn bị môi trường làm việc, quản lý dữ liệu, chạy các 

phần mềm ứng dụng cần thiết, lưu lại hoặc đưa các kết quả công việc ra ngoài, và kết thúc làm việc, tắt 

máy. 

2. Biết sự cần thiết phải thao tác đúng cách trong các trường hợp mở/tắt máy, mở/tắt hệ điều hành, mở/đóng 

chương trình ứng dụng, tắt một ứng dụng bị treo (non-responding). 

3. Biết một số quy tắc an toàn cơ bản, tối thiểu khi thao tác với máy móc, thiết bị: An toàn điện, an toàn 

cháy nổ, và các lưu ý an toàn lao động khác. 

4. Biết các cách khởi động (mở) máy. Biết sử dụng tên người dùng và mật khẩu để đăng nhập máy tính 

(đăng nhập hệ thống) một cách an toàn. Biết các cách để khởi động lại máy. 

5. Biết các chế độ tắt máy tính thông thường. Biết hậu quả của việc mất điện khi đang làm việc hoặc tắt 

máy đột ngột. 

6. Biết cách gõ bàn phím đúng cách. Biết các phím chức năng và phím tắt thường dùng. Biết cách kích hoạt 

và tắt bàn phím ảo. 

7. Biết chức năng và cách dùng các phím của chuột: phím trái, phím phải, phím (con lăn) giữa. Biết cách 

dùng bảng chạm (touchpad). 

8. Hiểu vai trò của màn hình làm việc (desktop). Nhận biết được các thành phần đầu tiên của màn hình làm 

việc như biểu tượng (icon), thanh nhiệm vụ (taskbar), thanh công cụ (toolbar). 

9. Biết cách thay đổi cấu hình màn hình làm việc của máy tính, cách lựa chọn ngôn ngữ của bàn phím (ví 

dụ: tiếng Anh, tiếng Việt). 
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10. Biết cách thay đổi hình nền, thay đổi giao diện, cài đặt, gỡ bỏ một phần mềm ứng dụng. 

11. Biết cách xem thông tin hệ thống của máy tính. Biết cách sử dụng chức năng trợ giúp có sẵn. 

12. Hiểu khái niệm biểu tượng (icon) và chức năng của nó. Nhận biết các biểu tượng thông dụng: tệp, thư 

mục, phần mềm ứng dụng, máy in, ổ đĩa, thùng rác, biểu tượng “đường tắt” (shortcut). 

13. Biết cách lựa chọn và di chuyển biểu tượng. Biết cách dùng biểu tượng để mở một tệp tin, một thư mục, 

một phần mềm ứng dụng. Biết cách xóa và khôi phục biểu tượng. 

14. Hiểu khái niệm cửa sổ (window) và chức năng của nó. Nhận biết được các thành phần sau đây của một 

cửa sổ: thanh tiêu đề, thanh chọn chức năng (menu), thanh công cụ (toolbar), thanh thể hiện trạng thái 

(status bar), thanh cuộn màn hình (scroll bar), và công dụng của chúng. 

15. Biết cách mở một cửa sổ mới, kích hoạt một của sổ hiện có. Biết cách thu hẹp, mở rộng, phục hồi, thay 

đổi kích thước, di chuyển, đóng một cửa sổ. Biết cách di chuyển từ cửa sổ này sang cửa sổ khác. 

III. Module sử dụng Internet cơ bản (Mã IU06) 

1. Hiểu thuật ngữ Internet. 

2. Biết các ứng dụng chính của Internet: truyền thông - liên lạc, chuyển tệp, tra cứu và cung cấp thông tin, 

làm việc và kinh doanh trực tuyến. 

3. Hiểu khái niệm dịch vụ Internet và vai trò của nhà cung cấp dịch vụ Internet (ISP) 

4. Hiểu thuật ngữ World Wide Web và web. Hiểu các khái niệm: địa chỉ của một tài nguyên trên Internet 

(URL - Uniform Resource Locator), cấu trúc và các thành phần của nó; siêu liên kết (hyperlink). 

5. Hiểu các khái niệm trang thông tin điện tử (website), trang web (webpage), trang chủ (homepage). 

6. Hiểu khái niệm và chức năng của trình duyệt web (browser) và biết tên một số trình duyệt web hay dùng 

như Mozilla Firefox, Chromium, Internet Explorer, Opera. 

7. Biết khái niệm bộ (máy) tìm kiếm (search engine) và biết tên một số bộ tìm kiếm phổ biến. 

8. Biết về một số rủi ro khi tham gia vào cộng đồng ảo và hoạt động trực tuyến như vô ý tiết lộ thông tin cá 

nhân, bị quấy rầy, bị lợi dụng. 

9. Hiểu khái niệm và vai trò của việc mật mã hóa (encryption) đối với một số nội dung khi truyền đi trên 

Internet. 

10. Hiểu khái niệm và vai trò của tường lửa (firewall), biết cách bảo vệ các mạng bằng định danh truy nhập 

(tên người dùng và mật khẩu). 

11. Nhận biết một website được bảo mật (Ví dụ: giao thức https, ký hiệu “khóa”). 

12. Biết về các lựa chọn để kiểm soát việc sử dụng Internet (Ví dụ: đối với trẻ em): giám sát, hạn chế duyệt 

web, giới hạn các trò chơi máy tính, hạn chế thời gian sử dụng máy tính.  

13. Biết cách mở, đóng một trình duyệt web. Biết cách sử dụng chức năng trợ giúp của trình duyệt. 

14. Biết cách nhập một địa chỉ web (URL) vào thanh địa chỉ và chuyển tới địa chỉ web đó. 

15. Biết cách hiển thị trang web trong cửa sổ mới, tab mới. 

IV. Module hiểu biết về CNTT cơ bản (Mã IU01) 

1. Trình bày khái niệm máy vi tính, máy tính cá nhân. Phân biệt máy để bàn, máy xách tay, máy tính bảng. 

2. Phân biệt thiết bị di động cầm tay như điện thoại di động, điện thoại thông minh (smartphone), máy tính 

bảng (tablet) và công dụng của chúng. 

3. Phần cứng máy tính là gì. Phân biệt thiết bị trung tâm và thiết bị ngoại vi. Biết các thiết bị ngoại vi chính: 

Thiết bị lưu trữ, thiết bị xuất/nhập, thiết bị mạng và truyền thông. Biết các thiết bị ngoại vi được nối với 

thiết bị trung tâm qua các cổng. 

4. Biết các thành phần cơ bản của máy tính điện tử: Bộ xử lý trung tâm (CPU), bộ nhớ trong. Biết các đơn 

vị đo tốc độ của bộ xử lý trung tâm. Phân biệt bộ nhớ động (RAM) và bộ nhớ chỉ đọc (ROM). Biết các đơn 
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vị đo dung lượng bộ nhớ trong như KB, MB, GB. Biết đơn vị đo tốc độ truy cập của bộ nhớ trong như Hz, 

MHz, GHz. 

5. Biết các loại phương tiện lưu trữ chính: Đĩa cứng trong, đĩa cứng ngoài, các loại đĩa quang (CD, DVD), 

thẻ nhớ, ổ nhớ di động. Biết các đơn vị đo dung lượng lưu trữ như bit, byte, KB, MB, GB, TB. Biết các 

đơn vị đo tốc độ quay của của ổ cứng (rpm - rounds per minute) và đo tốc độ ghi/đọc của phương tiện lưu 

trữ (bps - bits per second). Biết khái niệm lưu trữ trên mạng, lưu trữ tệp tin trực tuyến. 

6. Biết các thiết bị nhập thông dụng và cách nối chúng vào máy tính: Bàn phím, chuột, bi lăn (trackball), 

bảng chạm (touchpad), bút chạm (stylus), màn hình cảm ứng, cần điều khiển (joystick), máy ghi hình trực 

tiếp (webcam), máy ảnh kỹ thuật số, mi-crô (micro), máy quét ảnh (scanner). 

7. Biết một số thiết bị xuất thông dụng và cách nối chúng vào máy tính: Màn hình, màn hình cảm ứng, máy 

in, loa, tai nghe. 

8. Biết các cổng thông dụng: Cổng nối tiếp, cổng song song, cổng nối tiếp vạn năng (USB), cổng mạng. 

9. Hiểu khái niệm phần mềm và vai trò của phần mềm. Phân biệt hai loại phần mềm chính: phần mềm hệ 

thống (Ví dụ: hệ điều hành) và phần mềm ứng dụng. 

10. Hiểu chức năng của hệ điều hành, biết tên của một số hệ điều hành thông dụng (ví dụ: Ubuntu, Linux, 

Windows, Mac OS). 

11. Biết chức năng của một số phần mềm ứng dụng thông dụng: Xử lý văn bản, bảng tính, hệ quản trị cơ 

sở dữ liệu, trình chiếu, thư điện tử, trình duyệt web, biên tập ảnh, trò chơi máy tính và một số phần mềm 

khác. 

12. Hiểu khái quát cách thức và quá trình tạo ra phần mềm. 

13. Biết khái niệm phần mềm nguồn mở, phân biệt được phần mềm thương mại và phần mềm nguồn mở. 

Biết tên và chức năng của một số phần mềm nguồn mở thông dụng xử lý văn bản, bảng tính, trình chiếu, 

thư điện tử, trình duyệt web, biên tập ảnh. 

14. Biết khái niệm hiệu năng của máy tính: tốc độ bộ xử lý trung tâm ( ví dụ: MHz, GHz), dung lượng 

RAM, tốc độ ổ cứng, vai trò của bộ xử lý đồ họa. 

15. Hiểu ảnh hưởng của việc chạy nhiều ứng dụng đồng thời đến hiệu năng của máy và tác dụng của giải 

pháp đóng bớt các ứng dụng đó. 

 




